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Installing the ALER Plug-in for VS. NET

Overview

ALER integration with Visual Studio .NET provides users with the ability to easily search for and use assets
from the repository without leaving the VS .NET IDE environment. Assets and any associated artifacts are
downloaded directly to your VS .NET solution. Repository Access within the VS .NET solution also provides
a view into ALER that enables you to download artifacts and assets from the repository, query the
repository, and view the contents of the repository.

ALER can automatically detect asset reuse within the development environment. This allows development
teams to ensure that they get asset reuse credit, regardless of whether the assets have been downloaded
through ALER. For more information, see Enabling Advanced Usage Detection Options.

Prerequisites

. Microsoft Visual Studio 2005.

. Microsoft Visual J# 2005 runtime. (If J# is not installed on your machine, the installer will prompt
you download the correct version from Microsoft.)

. The VS .NET Always show solution option should be selected (Tools -> Options -> Projects and
Solutions -> General).

. Users must be assigned to at least one ALER project. A Project Administrator can assign users
to projects using the ALER Projects page.

. If your ALER is or will be secured by Siteminder, you will need to configure the policy server to
ignore (or unprotect) the following URL to allow the OpenAPI integration to function properly:

http://appserver. exanpl e. com ALER/ servi ces/

Installation

1. Download the VS .NET plug-in Zip file from your ALER instance at the following URL:

http://appserver. exanpl e. coml ALER-web/ i nt egrati on/ dot net/
ALERFor Vi sual Studio_3_0. zip
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2. Unzip the ALERFor Vi sual St udi o_3_0. zi p file.
3. Locate and run the set up. exe program.

4. Follow the prompts to select installation parameters.

i’z BEA Aqualogic Enterprise Repository Adapter Add-in for Visual... = |

Select Installation Folder

Thee izt aller wall inartall BEA Aqualogec Entespetzs Repositony Adaphes Add-n for Vieual Shudo NET

bor Hhe followsing Folder.

To instal in this folder, click "Mext"”. To install to & diferert folder, enter it belowe of click "Browse”
Eolder
|C:\Program Fies\BEA Systems\BEA Aqualogic Enterpeise Reposito, | Browse..

| Disk Cost..

instal BEA Aqualogic Entesprise Reposiony Adapier Adddn for Yisual Studio . MET for yoursel, or
For arone who uses this computer:

) Eveapons
) Just me

5. Click Finish to complete the installation.

6. Follow the instructions in Configuring the Connection to ALER from VS .NET to configure and
establish a connection to an ALER instance from VS. NET.
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Configuring the Connection to ALER from VS .NET

Follow these steps to configure and establish a connection to an ALER instance from VS. NET.

1. Launch Visual Studio .NET.

2. Open the Tools menu and click Options.

3. On the list of options, click the ALER Add-in for Visual Studio .NET option and provide the required login
information.

Dptions
T D S— | ALER Add-in for Visual Studio . MET® Login wI00BOT1221_1630
+- Progects and Sclutions
+ - Source Control siphid s
#- Text Editor User Hamsa:
- ALER Add-n for Visual Sthudio (HET
1 - Database Tools User Pagsword:
- Debugging
+ Device Tooks Agvancad Optione | | Establish Connaction
H- HTML Designer
H - Windows Forms Desigrisr
Oplions

[] Adamaticaly register dawnloaded Assst files

L_ox J[ coms |

o ALER URL
« The URL of the ALER instance. For example: htt p: / / appser ver . exanpl e. conf ALER

Note: Do not include the i ndex. j sp used in the default home page as part of the
URL.

4. User Name
o The user name to connect as.

5. User Password
o The password to connect with. Passwords are case-sensitive.

6. Establish Connection
o Click to verify a valid connection.

7. Automatically register downloaded Asset files
o If selected, downloaded asset files are registered with the Windows Registry, as appropriate. This may
be overridden on an case-by-case basis for each asset download.
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10.

Click the Establish Connection button to connect to the ALER instance you specified.
Optionally, click the Advanced button to enable additional ALER options:
o Usage detection for VS .NET Solution Projects
o Automated usage detection of referenced DLLs, WSDLs, and allow local caching of SFIDs (if SFID is
enabled at your installation)
o File name patterns to include and exclude

For more information, see Enabling Advanced Usage Detection Options.

Click OK when finished.
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Enabling Advanced Usage Detection Options

Follow these steps to enable advanced configuration options, such as enabling automatic usage detection of DLLs, WSDLs, local caching
of SFIDs, and file pattern detection.

Overview of SFID

If SFID is enabled at your installation, ALER can automatically detect asset reuse within the development environment. This allows
development teams to ensure that they get asset reuse credit, regardless of whether the assets have been downloaded through ALER.
Automated Usage Detection relies on a fingerprinting process, called Software File Identification (SFID), which tags selected files within an
asset with a unique ID. This SFID is then used to detect when and where an asset is used, even if the asset was acquired through means
other than the ALER Use - Download process. An instance of usage is recorded by ALER when tagged files within the asset are brought
into the developer's IDE, and a new build or build clean occurs.

SFID is available only in the Advanced Edition of ALER. See the ALER Software File Identification Guide for more information.

Configuring Automatic Usage Detection

1. Launch Visual Studio .NET.

2. Open the Tools menu and click Options.

3. On the list of options, click ALER Add-in for Visual Studio .NET to reopen the Login window.
4. Click the Advanced Options button to open the Advanced Settings window.

Use the Detect Usage tab to enable usage detection for VS .NET Solution Projects.
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Advanced Settings

Detect Usage | Automated Usage Detection | File Pattem Detection |

Detect Usage in Solution Projects
{*) Enabled () Disabled

Dione ] [ Cancel

5. Click the Automated Usage Detection tab to enable usage detection of referenced DLLs, WSDLs, and allow local caching of
SFIDs.

Advanced Settings

Detect referenced DLLs

{*) Enabled {7 Disabled
Detect web referenced WSDls
{(3) Enabled () Disabled

Cache Calculated SFIDs

(¥} Enabled () Disabled

Done ] [ Cancel
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6. Click the File Pattern Detection tab to specify include and exclude file name patterns.

Advanced Settings

| Detect Usage | Automated Usage Detection | File Pattem Detection |

Include file pattems : | |

Exclude file pattems : | |

Pattems are seperated by a comma ("=any string, 7=any character)

Done ] [ Cancel

7. Click Done to save your settings.
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Configuring .NET Projects for Automatic Usage Detection

In order to automatically detect usage, a .NET project must be monitored.

1. Open the .NET Solution Explorer.

2. Right-click the solution in the file tree and select the ALER Add-in for Visual Studio .NET option from
the context menu.

3. Click Projects Monitored from the submenu.

Solution Explorer

2 E]
= A
Assign ALER Project ALER Add-in for Visual Studio .NET » —
| Projects Monitored sk Build Solution
| E" Rebuild Solution

Clean Solution

| BatchBuid...

Configuration Manager...

Project Dependencies. ..

= . .

Praoject Build Qrder... reas Mathod

Add b

>

Set StartUp Praojects... :

9

E Rename

: Properties

ol - i

o gﬁ Form1.Designer.cs L

~- =] Program.cs o

il ' i | ¥

4. In the MonitoredProjects window, select the .NET projects that you want monitored for automated
usage detection.
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MonitoredProjects |Z| |E| |z|

WindowsApplication 1
ClassLibrary1

5. Click OK when finished.
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Assigning an ALER Project to a .NET Solution

In order to track the usage of downloaded assets, an ALER project must be assigned to a .NET solution.

Note: Before using this feature, you must be assigned to at least one ALER Project by a Project
Administrator.

1. Open the .NET Solution Explorer.

2. Right-click a solution in the file tree and select the the ALER Add-in for Visual Studio .NET
option from the context menu.

3. Click Assign ALER Project from the submenu.

Soltion Explcrer

=

_E ClossLbraryl | ALER Add+n for Visual Studio NET » |L _amm_ﬁtmm]

+ o Reference
L & MER el B Busd Solubon
# [ xmds Bebuld Solustion
Y Asseerbiyl Babch Buid. .
[*] Class],eq
= 58 wind - Configuration Mansger...

+ ‘Gl Reference Project Dependendes...

= {3 ALER Refe
= £5 umds Project Build Order. . .
e
i -\mﬂ = '
] Assembiyl Set StartUp Brojects. ..
EE Formi.cs Debug "
[ 5ave Solutionl.sin
& saeM
E — | Rename
lrdy Properties
Sroperter 3 X

4. In the Project Selection window, use the Select the ALER Project drop-down list to view the
ALER projects that you are assigned to.
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™ oject Selection

i) FA Project Salaction

Select the ALER Project
Progact-01 w

||':l:|mn1|:-n F'rnﬁ i

| Fosh | [ Concel |

Note: If the list is empty, you have not been assigned to any projects and the procedure must be
canceled.

5. Select an ALER project from the list.

6. Click Finish to save your changes.

Copyright © 1995-2008 BEA Systems, Inc. All Rights Reserved. Page 12 of 22



Searching for Assets

Perform a simple keyword search in VS .NET to locate an asset in ALER in order to view the asset's
metadata.

1. Open the View menu.

2. Click the ALER Add-in for Visual Studio .NET option and select View Asset Search Window
from the submenu.

v WindowsApplication1 - Microsoft Visual CF _NET [design]
Fle Edt | Vew | Projct Bud Debug Tooks Wndow Hep

- u| ALER Add-n for Visual Studio NET » View Assel Search Window

Start Page

| Tocbax oh Solution Exglocer Cirlsalts View Search Resuits Window
My User Conl 8 Class View Ctrl +5hift +C
Clipboard Rin £ Seryer Explorer Cirl+Alt+5
General

F gesource view Cirl+5hift+E

3. The ALER Asset Search window appears.
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ALER Asset Search z x|

Keyword:

Type:

Al Types o]
Function:

All Asset Functions [

Search |

BEA Aqua Logic Enterprise Repaositary

i ALER Asset Search | E Solution Explarer |

4. Type a keyword or phrase into the Keyword box.
5. Use the Type and Function drop-down lists to refine the search.

6. Click the Search button. The ALER Search Results window displays a list of all assets matching
the search criteria.

it ey
B () Sevphs bppossen - SLES rsr—
Bl (B Sorels lopleaten - Ca Card dot Sy Sapplat i
| B (@) Seveie Busitess Process - Deser Verbeston Frooess 10 Buamess Frotess
| |B] (@) Seveie Come Adscter - Custorer Crast inkormation 10 Comraricaion Adectel
| Bl (B Seveis Compomant HETFind ddrvas Meed Beta Fotesns Comporart
| (I Semgle Component JOEE - Drder EJB 10 Cormpcrant
| ﬂ'i (& Serpis Erveorerent - Tomopt it ot
4

7. Click the Display Details icon for any listed asset (or double-click the row) to view the asset's
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detail display.

.

=
8. Click the Download “#/

.

#/icon for any listed asset to download the asset.
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Downloading Asset Artifacts

You can download an asset's artifacts (i.e., payload) into a VS .NET project. Typically an asset payload is
usually the functionality that a developer needs to use a service (such as a WSDL file) or incorporate into
their code base (usually a binary). Within the asset metadata, links to supporting documentation, user
guides, test cases, etc., are provided to better enable developers to reuse existing functionality.

1. Perform a keyword search to locate an asset in ALER, as described in Searching for Assets

2. Inthe ALER Search Results window, click the Download @ icon.

ALEH Zpiarch Bt | LY iecond Found
hew | WL | Asat Hame ' ErPrR— Eaur Tyoe
Bl (&) Seesple Applecston - BCES Apphoaie
L FI' 41 Sarvple Applet st « Covrrrerial Cavdl Sadlwnnraleon Syt ]
E] ()  Samphe Butreid Prooess - Ondet Venkoason Process il ] Cuderssid Proceas
E._'! (i) Sample Comm Adapter « Contomar Credd islormation k1] T omrrurenaton ddaphen
g .'._"" Sarrpls Comporard NET.Fimd Sidrpan Bphod Exin Fplpane Lomporars
E .."" Sampls Comporant JIEE - Oeder EJB i} Comporent
Bl (& Sesrpks Ervironment - Tomcst &1 Lrrorgrmen
L]

3. Select the VS project that you want to download the asset's files into, and then click Next.
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E: Derermvload ALER Assed

Wisual Shucho Propect Selection

The ALER sszat wall ba dvanloadad inko the selaciad Visual Studho Progact

Windows Appdcation 1

4. Select the asset files to download, and then click Finish.
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™ Download ALER Asset
Zsset File Selection
A1ER Project Agael Files:
| project-00

Visual Studio Project
| WindowsApplication]

W Asomatically register Asse files

5. If necessary, launch the Solution Explorer.
6. A new folder labeled ALER References will appear in the project's file tree. This folder contains a

subfolder bearing the name of the downloaded asset (for example, "xmd5 (1.0)" in the illustration
below). This folder contains the asset's artifacts.
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Solution Explorer - WindowsApplication 1

F 3 | &
' E Solution ‘Solution 1’ (2 projects)
= @ Classlibrary1
[+ = References
= I3 ALER References
#- (L3 »xmdS (1.0)
EI AssemblyInfo.cs
El Classl.cs
= [3¥ windowsApplication1
[+ ) References
= {3 ALER References

= a M k

- ) App.ico
#] AssemblyInfo.cs
B8 Forml.cs

@ ALER Aszat Search E Solution Explorer
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Viewing Asset Details

The Asset Details view provides asset details for any listed asset in an embedded Web-based browser view, which calls out the enterprise repository
application for details associated with the selected asset.

1. Perform a keyword search to locate an asset in ALER, as described in Searching for Assets

2. Inthe ALER Search Results window, click the Display Details icon.

ALER opens to display information on the selected asset, as shown here:

spolication: Sample Application - Commercial Card Authorization System -

»

Sample Application - Commercial Card Authorization System Ho Reviews Posted

Submit & Rais

Description:
THIS ASSET I5 TO BE USED AS AN EXAMPLE. [T HAS BEEN POPULATED WITH SAMPLE METADATA, ALL FILES AND
MITADATA AR TOY B0 USED FOR TRATNING PURPOSES ONLY.

Frequency of Change: High
Primary Driver of Changes: Defects,

Buminsas dif m

The COTS system handles all major types of redit and debit card fransactions. 1t provides the functions necessany to
authorize and capbare slectronic trai ctiare that suppart the company’'s dey-to-day billing requirsmente. Treneschons
arw proceded on @ resl-bima, one-by-cne basis. Trandactions can alio be batched, baded on Bulineis reduiremerts.
In addition to the Basie bansation irformation. the systam captures addtional infarmatien abaut the sata indudeng
item descriptions and invoice-specific data

Alno Known As: CAS Consistent with business mission:
e
Passes lngal revsew: yea
Passes technical review: pax
Expected Avsilability Date: 2007
Ernail Adddress 10-15
Business Cwner John Jones WP of Product Line 1 J33-933-1212 fipnes@expmple.com

Targeted Users: Customers. Employess
Arguisition Method: COTE

Owners | Sponsoes

Executive Sporwor  Carol COlark  Senior VP of Broduct Line 1 558-358-1213  colarkfexample.com

IT Crearsar Dwan Evarns Managar Cradit Card Precassing 555-555-1Z14 iy e R S 1 Y

Required Certifications:

Oate Comments

Cartification Diake Certified CrtiFrcation Bady Recestificatinn Dake M|

Sarbarnee-Oxley Internsl Audit Taam i.0 20040101 Initsal

150 150 Audite canaralled

el ibar releass fo L

£ ¥
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Accessing Repository Assets in a Project

The Repository Assets view displays a list of assets that have been prescribed to your project, as well as assets that are already in use in the project.

About ALER Projects

Through the Enterprise Repository, analysts, architects, technical leads, and others that are involved in the design stages of a project, can create a list of assets that
might fulfill a project's requirements. The lists of assets are captured in compliance templates in the repository, and the compliance templates are associated with an
ALER project. For more information on compliance templates, refer to the ALER Compliance Templates Guide.

Note: Compliance Templates are available only in the Advanced Edition of ALER.

From the Repository Assets view, you can view a list of assets appearing in all of the Compliance Templates assigned to your project. The viewer will indicate which
of the assets have been used by you and/or other project members. The viewer will also display other assets that are already in use in the project.

Accessing the Repository Assets View

1. Open the View menu.

2. Click the ALER Add-in for Visual Studio .NET option and select Repository Assets from the submenu.

#% Solution1 - Microsoft Visual Studio
Fle Edt |ven | Project Bud Debug Dats Took Window Commnity reb
al- _|.*| ALER Add-in for Visual Studio NET >| View Asset Search Window

7 %8 server Explorer cerl+w, L View Search Results Window
&3 Solution Explorer Coi+w,5 | Repasitory Assets i
ALER Log

3 Bookmark Window Ctrl+, B

3. The Repository Assets window displays.

« Asset is prescribed by applied Compliance Template.
« Asset is used by user.
«Asset is used by project member.

Pepriritony Aasets (5 recee o Pouraf)

Assel Haew L Wedain As5el Typs )
Sarpls Appication - Conmarcad Card futhormation Syatem Apphcation FRESCABED

! (@) Sample Compeeset NET-Find iakdess Wathed Bets Fisdense Comvgesest 1N PROCESS

i Y & SarvhsFatar - MVT Damige 10 Faturr FRESCRBED
@ T @ SeroleFanen - View Hdper Dusige m Frtein 1N FROCESS

i B &% Serpls Frocesen - SCRLM 10 Frocazars FRESCREED

4. Click the Display Details icon for any listed asset (or double-click the row) to view the asset's detail display.

5. Click the Download @ icon for any listed asset to download the asset.
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Accessing the ALER Log

1. Open the View menu.

2. Click the ALER Add-in for Visual Studio .NET option and select ALER Log from the submenu.

3. The ALER Log window displays.

ALER Log ()

4. Click Clear to remove the log entries.
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